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  Gli articoli contenuti in questa rivista sono stati rilasciati sotto la licenza Creative Commons Attribuzione - Non commerciale - Condividi allo stesso modo 3.0. Ciò significa che potete adattare, copiare, distribuire e inviare gli articoli ma solo sotto le seguenti condizioni: dovete attribuire il lavoro all'autore originale in una qualche forma (almeno un nome, un'email o un indirizzo Internet) e a questa rivista col suo nome ("Full Circle Magazine") e con suo indirizzo Internet www.fullcirclemagazine.org (ma non attribuire il/gli articolo/i in alcun modo che lasci intendere che gli autori e la rivista abbiano esplicitamente autorizzato voi o l'uso che fate dell'opera).

  

  Se alterate, trasformate o create un'opera su questo lavoro dovete distribuire il lavoro risultante con la stessa licenza o una simile o compatibile. Full Circle è completamente indipendente da Canonical, lo sponsor dei progetti di Ubuntu, e i punti di vista e le opinioni espresse nella rivista non sono in alcun modo da attribuire o approvati da Canonical.


  
    Nota: gli articoli in questa magazine sono forniti assolutamente senza alcuna garanzia; né i contributori né Full Circle Magazine accettano alcuna responsabilità o onere per perdita o danneggiamento risultato dalla scelta dei lettori di applicare questi contenuti ai computer loro o di terze parti od equipaggiamenti.
  


  Inizia la serie su Blender...


  In questo volume iniziamo ad assemblare la serie di Nicholas Kapakakis su Blender.

  

  Quella che avete davanti è la ristampa della serie Blender, parti 1 -1 0, pubblicata dal numero 68 al numero 82.

  

  Vi chiediamo, però, di badare alla data di pubblicazione: le versioni attuali di hardware e software potrebbero essere diverse rispetto ad allora. Controllate il vostro hardware e il vostro software prima di provare quanto descritto nelle guide di queste edizioni speciali. Potreste avere versioni più recenti del software installato o disponibile nei repository delle vostre distribuzioni.

  

  Buon divertimento!


  Blender - Parte 1


  di Nicholas Kopakakis


  È piuttosto bislacco iniziare un articolo con un link per Youtube, ma penso che se vi piacerà ciò che visualizzerete, amerete anche tutti i rimanenti tutorial come questo.


  Sentitevi liberi di seguire il collegamento qui sotto e di tornare qui tra circa 15 minuti, ripetendo la procedura per il numero delle volte che vi aggrada: http://www.youtube.com/watch?v=eRsGyueVLvQ


  Sintel (www.sintel.org) non è la ragione per la quale ho cominciato a pasticciare con Blender, ma ritengo che se non l'avessi fatto fino a quel momento, avrei certamente “intrapreso il mio viaggio” subito dopo.


  Quindi, parliamo di Blender (www.blender.org), il programma che è dietro Sintel e molte animazioni simili (di fatto Blender è dietro molte questioni che riguardano il 3D). Blender è disponibile per Linux, Windows, Mac OS X e FreeBSD (sia per sistemi 32-bit che per 64-bit).


  Quando è stato scritto questo articolo la più recente versione era la 2.64, ma noi lavoreremo con la 2.62 che potrete trovare nei repository di Ubuntu. Se non l'avete ancora installata, procedete e installatela dal repository.


  In questi tutorial useremo un mouse a 3 tasti e una tastiera con tastierino numerico. Blender presume che li abbiate entrambi. Ma, se non fosse così, potete cambiare tali impostazioni andando in File>User Preferences. Selezionate la scheda Input e, sulla sinistra, mettete la spunta su Emulate 3 Button Mouse e Emulate Numpad.


  Vi troverete innanzi ad una schermata di caricamento che mostra nell'angolo in alto a destra la versione di Blender e alcuni link. Per ora ignorateli e premete qualsiasi pulsante del mouse in un punto fuori da tale area.


  Se siete nuovi ai programmi di animazione 3D, non disperate. Concedetegli un po' di tempo e ci farete l'abitudine: provare, sperimentare e provare ancora sono i soli tre modi per eccellere in Blender. Se avete dimestichezza con programmi similari (Maya, 3DS, Max, ecc), troverete qualcosa di diverso ma la filosofia principale rimane la stessa.


  Quindi, siamo in Blender e vediamo l'editor 3D view, qualche pulsante sulla sinistra, qualche pulsante e dei numeri sulla destra e una linea temporale in basso. Lavorare in Blender significa soprattutto “lavorare sul 3D view modifier”.


  Lavorare con Blender implica modellare, animare, illuminare, comporre, dare texture (useremo tutti i modificatori), ma il 3D view modifier (o finestra della Vista 3D) è il posto dove viene sempre visualizzata ogni modifica.


  L'editor Vista 3D è la grande finestra al centro del nostro schermo. Potete osservare al suo interno un cubo, una videocamera e una luce.


  Premete F12.


  Cosa succede? Beh, avete già renderizzato la vostra prima scena su Blender!


  
    SUGGERIMENTO: Potete ispezionare le immagini renderizzate in precedenza premendo in qualunque momento F11. Premendolo ancora tornerete all'editor della vista 3D.
  


  Muovete il mouse sull'immagine e premete Esc o F11 per uscire dalla finestra con l'immagine renderizzata e tornare al 3D View Modifier.


  Ciò di cui necessitate per avere una scena completa è un dispositivo di ripresa (la videocamera), un soggetto da immortalare (il cubo) e alcune luci.
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  Ora focalizziamo la nostra attenzione sulla barra sotto la finestra Vista 3D, chiamata Header (e illustrata in basso).
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  Notiamo la piccola scatolina che si trova dalla parte sinistra. È il selettore del tipo di modificatore.


  Fare clic con il TSM (Tasto Sinistro del Mouse) sulla piccola scatolina 3D per cambiarne la modalità d'azione.


  Dalla lista, selezionate Python Console (la prima voce in alto).


  Hey! Dov'è finita la mia scatola?


  Non abbiate paura, il vostro cubo è sempre là dove lo avete lasciato. Dallo stesso menu selezionate 3D View. Voilà! La vostra scatola è lì. Vedete?


  In Blender, potete cambiare ogni finestra in ogni tipo di modificatore che volete. Sarà una caratteristica molto utile in futuro, quando vorremo essere più produttivi. Andate avanti e trovate le altre quattro intestazioni di finestra sul vostro schermo (ce ne sono cinque in tutto).


  Notate che ogni finestra ha diverse intestazioni con diverse opzioni, e ogni volta che cambierete il modificatore, l'intestazione cambierà di pari passo.


  Adesso cambiate ogni modificatore in info (l'intestazione in alto nello schermo è già su info, quindi non dovrete cambiarla).


  In qualunque momento, premete File>New nell'intestazione info per ricaricare le impostazioni predefinite.


  OK. Iniziamo un nuovo progetto. Premete File>New nell'intestazione info.


  Tutto è tornato al proprio posto.


  Muovete il mouse nella finestra dell'editor di vista 3D e premete il TCM (Tasto Centrale del Mouse) mentre spostate il cursore alla rinfusa. State ruotando la vista. Muovendo la rotellina del mouse in su e in giù invece farete degli zoom in avvicinamento o allontanamento.


  Alt+Shift+Rotellina del Mouse si usa per ruotare la vista su e giù.


  Alt+Control+Rotellina del Mouse ruota la vista a destra e a sinistra.


  Potete anche fare una panoramica (pan) della vista. Shift+TCM si usa per effettuare il pan, Shift+Rotellina del mouse per andare su e giù o Control+Rotellina del mouse per andare a destra e sinistra.


  Potete ingrandire o rimpicciolire anche senza usare la rotellina del mouse. Usate Control+TCM, muovendo in alto (per ingrandire) o in basso (per rimpicciolire).


  È abbastanza per oggi con le rotazioni e il pan. Vediamo come selezionare!


  Iniziate un nuovo progetto: File>New. Come predefinito quando cominciate un nuovo progetto, il cubo è selezionato (l'indicatore di cosa è selezionato sono gli spigoli del cubo illuminati d'arancione).


  Adesso premete il tasto A.


  Deselezionerete il cubo (e nulla sarà più illuminato nella scena).


  Premendo A di nuovo, selezionerete tutti gli oggetti nella schermata: il cubo, la videocamera e le luci. Premete ancora A per deselezionare ogni cosa.


  Ora premete il TDM (Tasto Destro del Mouse) sul cubo. Avete selezionato il cubo e ora è in evidenza.


  Clic con il TDM sulla luce. Avete ora selezionato la luce e contemporaneamente deselezionato il cubo.


  Premete A per rimuovere dalla selezione la luce.


  Selezione con Shift


  Premete il TDM sulla luce e quindi premete Shift+TDM sul cubo. Avete selezionato la luce E il cubo (notate i bordi della luce che danno più sul rosso).


  Adesso premete Shift+TDM sulla videocamera (notate ancora gli spigoli rossi). Questa è la selezione d'insieme, ossia avete aggiunto la videocamera alla selezione precedente.


  Usate la combinazione Shift+TDM sul cubo.


  I bordi rossicci diventano arancioni. Shift+TDM ancora sul cubo per deselezionarlo. Adesso avrete in selezione la videocamera e la luce. Premete A per deselezionare ogni oggetto.


  Adesso, usando il TCM, ruotate la vista, in modo da vedere tutti e tre gli oggetti, e deselezionateli tutti con il tasto A (potreste anche caricare una scena tutta nuova selezionando File>New o Control+N, e sul nuovo progetto premere A per deselezionare il cubo).


  Strumento di selezione Riquadro


  Prendendo per certo il fatto che abbiate caricato un nuovo progetto o che abbiate una vista similare, muovete il mouse sopra a destra della luce e premete il tasto B. Compare una croce. Adesso tenete premuto il TSM e trascinate il mouse in basso a sinistra in modo che il Riquadro selezioni tutti e tre gli oggetti.


  Mitico! È tutto selezionato in un modo differente e più rapido rispetto alla selezione con Shift+TDM.


  Premete A di nuovo per annullare la selezione.


  Strumento di selezione Cerchio


  Premete C e apparirà un cerchio.


  La selezione Cerchio lavora in modo cumulativo, come avviene premendo il tasto Shift per selezionare, quindi fare clic col TSM sul cubo aggiungerà il cubo alla selezione.


  Muovendo la rotellina del mouse su e giù, potrete aggiustare il raggio del cerchio rendendo la selezione più precisa o più generica.


  Ricordate, ogni volta che premete il TSM aggiungete l'oggetto alla selezione corrente.


  Premete il TCM per rimuovere oggetti dalla selezione.


  Premete ESC per uscire dalla modalità selezione.


  Strumento di selezione Lazo


  Premete e tenete premuti Control+TSM e trascinate il mouse per fissare dei bordi attorno ad un oggetto. Potete selezionare più oggetti in maniera più accurata rispetto allo strumento di selezione Riquadro.


  Potete aggiungere oggetti alla selezione con la combinazione Control+TSM, e potete sottrarre degli oggetti dalla selezione con l'aggiunta del tasto Shift alla combinazione: Control+Shift+TSM. Tenete premuto Control+Shift+TSM e sottraete degli oggetti dalla selezione.


  Andate su File>New o premete Control+N. Avviate un nuovo progetto.


  Fate pratica, esperimenti e PRATICA! Ruotate le viste, pan sulla schermata, ingrandimenti, rimpicciolimenti, selezioni multiple e deselezioni.


  Il prossimo mese, creeremo davvero qualcosa.


  Andate su http://www.youtube.com/watch?feature=player_embedded&v=R6MlUcmOul8


  Godetevi “Tears of Steel” (www.tearsofsteel.org) della Blender Foundation.

  


  
    Nicholas vive e lavora in Grecia. Lavora per una casa di post-produzione (pubblicità-film) da diversi anni. Tre mesi fa è migrato su Ubuntu perché “renderizza più velocemente”. Blender ha trovato lui due anni fa.
  


  Blender - Parte 2


  Scritto da Nicholas Kopakakis


  Come promesso lo scorso mese, oggi inizieremo a creare qualcosa. Ma prima di tutto, distruggiamo il cubo!


  Iniziate un nuovo progetto in Blender: File -> New, o aprite semplicemente Blender.


  Premete l'1 del tastierino numerico per avere una vista frontale. Nell'angolo in alto a sinistra potete accertarvi di cosa state visualizzando.


  Adesso premete il tasto 5, sempre del tastierino. Potete così cambiare la vista da “Prospettiva” a “Ortogonale”. Premendo il tasto 5 infatti si passa dalla vista in prospettiva a quella ortogonale e viceversa.


  
    Suggerimento: La modalità Prospettiva è la stessa di come i nostri occhi vedono il mondo. Gli oggetti più vicini sembrano più grandi di quelli distanti.
  


  Con la vista Ortogonale, d'altra parte, è come guardare un oggetto da una distanza infinita. Tutti gli oggetti sembrano essere alla stessa distanza rispetto agli occhi. La proiezione Ortogonale è uno dei modi per rappresentare un oggetto tridimensionale in due dimensioni (http://it.wikipedia.org/wiki/Proiezione_ortogonale), molto utile per la modellazione!
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  Nell'immagine in basso a sinistra abbiamo quindi una vista ortogonale. Il nostro cervello non può capire quale lato sia quello frontale. Ma è molto utile per creare modelli, dato che di fatto a noi non interessa propriamente la prospettiva, quanto le dimensioni effettive del nostro modello. La prospettiva sarà molto più realistica se creeremo modelli senza tener conto di essa!


  Nell'immagine in basso a destra, vediamo il cubo in maniera prospettica; in questo modo il nostro cervello comprende qual è il lato più vicino, sapendo che si tratta di un cubo.


  Ovviamente questa è una mia opinione. Può darsi pure che voi riusciate a modellare meglio e più rapidamente usando la vista in prospettiva. Tutto dipende dalle vostre capacità.


  Pochi mesi addietro, Mark ha cominciato a spiegare il grande programma Inkscape (in futuro vedremo come combinare Inkscape con Blender) creando un pupazzo di neve. Mi è molto piaciuto quell'esempio, quindi anche noi creeremo un pupazzo di neve. Ma prima, distruggiamo il cubo!


  Selezionate il cubo con il TDM e premete il tasto X o Canc, confermando poi l'eliminazione con il tasto Invio.


  Adesso premete Shift+A per aggiungere qualcosa e dal menu selezionate Mesh -> UV Sphere o dall'intestazione premete Add -> Mesh -> UV Sphere per aggiungere un nuovo reticolo alla scena. Ecco che appare una sfera.


  Immagino che vi troviate in una vista ortogonale-frontale (guardate nell'angolo in alto a sinistra della vostra finestra di vista 3D), con la sfera selezionata. Se non fosse così, premete 1 dal tastierino numerico.


  Premete Shift+A per aggiungere un nuovo reticolo, di nuovo una sfera UV. Non vedrete nessuna differenza sul vostro schermo. Niente paura, TSM e trascinate la freccetta blu che punta verso l'alto, per muovere la sfera lungo l'asse delle Z. Piazzatela vicino alla sommità della sfera che è rimasta fissa.


  Premete il tasto S per scalare la sfera muovendo il mouse verso il centro del cursore. Traslate ancora un po' la sfera verso il basso in modo che un pezzettino sia “nella” sfera più grande.


  Adesso premete Shift+D per duplicare la sfera selezionata. Premete Z per bloccarne il movimento alla sola asse Z, poi premete e tenete premuto il TSM per muoverla vicino alla sommità della seconda sfera.


  Premete S e scalate la terza sfera.


  È già qualcosa.


  Premete File -> Save As per salvare il vostro lavoro. Selezionate dove volete salvare il file, dategli un nome univoco (pupazzodineve.blend, ad esempio) e premete il pulsante Save As Blender File nell'angolo in alto a destra. Fantastico!


  Ora, selezionate la prima sfera premendoci sopra con il TDM. Premete S e quindi Z per scalare la sfera solo relativamente all'asse Z.


  Fate lo stesso per le altre due sfere in modo da renderle più “realistiche” (come mostrato al centro, a sinistra). La gravità schiaccia le palle di neve verso terra.
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  Premete N per aprire o chiudere il Transform Properties shelf sulla destra della vista 3D. Da qui, potrete visionare e modificare le proprietà del vostro oggetto numericamente (come mostrato al centro, sulla destra).
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  Nella vista ortogonale frontale, premete TSM in qualunque punto a destra del corpo del pupazzo di neve. Premete Shift+A per aggiungere Mesh -> Cone. Premete R per ruotarlo, e 90 per indicare l'angolo di rotazione.


  
    Suggerimento: Potete inserire manualmente dei valori semplicemente digitandone il valore. Potete anche usare valori negativi per ruotare gli oggetti in senso antiorario.
  


  Premete il 3 del tastierino numerico per avere la vista da destra. Premete S per scalare e Shift+X per vincolare la dimensione lungo l'asse delle X e modificare in contemporanea quelle su Y e Z. Scalate il cono in modo da dargli una dimensione simile ad una carota, relativamente alla terza sfera creata (la testa del pupazzo).


  OK, ora premete 1 per la vista frontale, quindi S e X per apportare modifiche solo relativamente all'asse X. Ora create un naso a carota lungo o corto.


  Premete R e -10 per ruotare il naso di 10° in senso antiorario.


  Usando la vista frontale e quella da destra, piazzate il naso da qualche parte al centro della testa del pupazzo.


  Ora creiamo qualche bottone. Premete Shift+A per aggiungere Mesh -> Cylinder. Usate lo stesso strumento usato per modellare il naso-carota per creare un bottone delle dimensioni di una moneta. Scalatelo, ruotatelo, usate la vostra immaginazione! Non dimenticate poi di duplicarlo con Shift+D per essere più produttivi.


  Quando sarete soddisfatti del vostro modello, salvate il vostro lavoro.


  Premete F12 per farne un rendering.


  Il pupazzo di neve sembrerà un tantino ridicolo. La neve non ha quei bordi, sembrano più dei cristalli ben realizzati! Dobbiamo smussarli un po'.


  Quindi, premete il tasto T per aprire il Tool Shelf e gli strumenti adatti sulla sinistra. Sotto la sezione Shading, avete due opzioni: Smooth e Flat. Con una sfera selezionata (o anche tutte) premete il tasto Smooth. Il vostro pupazzo di neve sarà ora più liscio!
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  Potete osservare la differenza. Nell'immagine al centro sulla destra, le sfere sono livellate come se fossero dei cristalli, mentre in quella sulla sinistra abbiamo applicato lo Smooth che conferisce levigatezza e naturalità alla neve.


  Usando lo strumento di selezione Riquadro che abbiamo visto il mese scorso, selezionate tutti gli oggetti che, uniti, rappresentano il “pupazzo di neve”. Le sfere, i cilindri e il cono.


  Usando la freccia blu, muovete il pupazzo di neve verso l'alto come mostrato nelle immagini qui sopra, giusto un pelino sotto l'asse rosso.


  Premete Shift+S. Dal menu Snap apparso, selezionate Cursor to Center. Premete il tasto 7 del tastierino numerico per la vista dall'alto. Premete Shift+A per aggiungere un nuovo elemento. Un Plane (un piano). Premete S per scalare il piano e 10 per scalarlo di 10 volte.


  Abbiamo un terreno.


  Salvate il vostro lavoro con un nome univoco.


  Renderizzate il pupazzo di neve premendo F12.


  Se la vostra videocamera non riprende il modello come desiderate voi, spostatela.
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  Ogni mese, vi suggerirò un sito interessante per Blender. Per questo mese, vi consiglio caldamentehttp://www.Blendernation.com, un sito molto utile con notizie fresche riguardo Blender.


  E anche per questo numero ho un video per voi. Andate suhttp://www.youtube.com/watch?v=TLkA0RELQ1g, e gustatevi “Elephant Dreams”, un corto d'animazione creato con Blender nel 2006 dall'Orange Open Movie Project.


  Il prossimo mese, aggiungeremo un cappello, una pipa probabilmente e delle mani simili a scopette. Inoltre, vi introdurrò l'Edit Mode (la modalità modifica), il luogo in cui andrete a spendere la maggior parte del vostro tempo in Blender!

  


  
    BIO: Nicholas vive e lavora in Grecia. Lavora per una casa di post-produzione (pubblicità-film) da diversi anni. Tre mesi fa è migrato su Ubuntu perché "renderizza più velocemente". Blender ha trovato lui due anni fa.
  


  Blender - Parte 3


  Scritto da Nicholas Kopakakis


  Per tante, tantissime volte nelle sessioni di Blender premerete il tasto TAB. È il tasto rapido per passare alla modalità Edit.


  Caricate il file pupazzodineve.blend che avevamo creato lo scorso mese e visualizzate sulla barra di intestazione il pulsante che mostra che siete in Object Mode (è chiamata intestazione ma è posizionata, come predefinito, dove dovrebbe esserci il pie' di pagina).
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  Selezionate con il TDM la testa del nostro pupazzo di neve (la sfera UV in cima).


  Premete il tasto TAB. Tutta la barra d'intestazione cambierà e ora leggerete “Edit Mode” sullo stesso pulsante di prima (in alternativa, potreste premere quel pulsante e da lì selezionare Edit Mode. Per ora, non abbiamo bisogno di sapere in cosa consistono le altre modalità).
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  Anche la sfera UV si trasforma in una sfera reticolata arancione.


  Siete in modalità Edit. In questo contesto sarete in grado di aggiustare e manipolare solo gli oggetti selezionati. Per esempio, provate a selezionare la luce o il naso con il TDM. Non potrete. È selezionabile solo un vertice o un gruppo di vertici dell'oggetto che si sta modificando. Il vertice è una coordinata tridimensionale, lo spigolo è una linea che connette due vertici e la faccia è lo spazio piano racchiuso fra tre o più vertici.


  In modalità Edit, potete selezionare vertici, spigoli e facce nello stesso modo visto nella prima parte di questa serie, 2 mesi addietro. Usate lo strumento di selezione Riquadro, il lazo, lo strumento di selezione circolare, TDM e Shift+TDM per selezionare più vertici.


  Anche nella barra di intestazione, osservate i tre piccoli pulsanti che rappresentano la selezione di vertici, spigoli e facce. Da questi pulsanti potete impostare cosa desiderate selezionare (vertici, spigoli o facce). In alternativa, premete sulla tastiera la combinazione rapida Ctrl-Tab.
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  Sulla barra di intestazione potrete notare ancora una volta che i pulsanti menzionati prima sono scomparsi e sono tornati alcuni vecchi tasti. Focalizziamo per un minuto l'attenzione sui pulsanti illustrati sotto.
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  Sono chiamati Layers Buttons. Il punto giallo nel pulsante in alto a sinistra indica che abbiamo degli oggetti in quel layer che erano stati selezionati o che lo sono stati di recente e il colore grigio scuro indica che ci troviamo correntemente in quel layer.



  Premete il numero 2 sulla vostra tastiera (NON sul tastierino numerico), oppure il secondo pulsante a partire dall'angolo in alto a sinistra. Tutto scompare, dato che ci troviamo ora in un layer differente. Premete Shift+S per il menu Snap e selezionate Cursor to Center. Premete Shift+A per aggiungere un nuovo oggetto. Dal relativo gruppo Mesh selezionate Cylinder. Guardate adesso i pulsanti Layer. .
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  Ci viene mostrato che abbiamo oggetti in due layer e il secondo di essi è anche il layer attivo con qualcosa di selezionato all'interno. Premete S per scalare e digitate 0.3 per rimpicciolirlo del 30%. Premete G per trascinare, Z per vincolarlo all'asse delle Z e 0.3 per muovere il vostro cilindro in alto del 30% rispetto ad un'unità di Blender.


  Se non è già selezionato, premete il 5 del tastierino numerico per cambiare la vista in Ortogonale (spiegazione in FCM #69) e il 7 del tastierino numerico per avere la vista dall'alto.


  Premete il tasto TAB per entrare nella modalità Edit. Qualora aveste spostato il cursore, premete Shift+S e Cursor to Center per muovere il cursore nuovamente nel centro della griglia. Premete Shift+A per aggiungere un Circle, dal menu Mesh. Dopo di ciò, premete F6 e, dalla finestra che si aprirà, modificate il Fill Type da Nothing a Ngon. Successivamente, premete S per scalare, 0.5 per rimpicciolire il cerchio del 50%.


  Premete il tasto TAB per ritornare alla modalità Object. Mentre siete in modalità Edit, gli oggetti che aggiungerete (come in questo caso il cerchio) saranno considerati parti di un oggetto solo e Blender li manipolerà come singoli oggetti.


  Abbiamo il cappello. Adesso creiamo le mani del nostro pupazzo di neve. Premete 3 sulla tastiera (NON sul tastierino numerico) per lavorare nel Layer 3.


  Ancora Shift+S per muovere il nostro puntatore al centro. Shift+A per aggiungere una nuova Mesh, ossia un nuovo cilindro. Premete S per scalare, Shift+Z per mantenere le dimensioni dell'asse Z e alterarle sugli altri due assi, X e Y. Premete 0.02 per scalare del 2%. Dopo questo, premete S nuovamente, Z per alterare solo le dimensioni dell'asse Z e 0.5 per dimezzarne la lunghezza. Torniamo ancora alla modalità Edit. Con il cilindro selezionato, premete TAB. Aggiungete un nuovo cilindro, scalatelo, ruotatelo e muovetelo in modo da creare un braccio ramificato.
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  Quando avrete creato il vostro rametto, premete Alt+1 sulla tastiera (NON su tastierino numerico) per selezionare il Layer 11.


  
    SUGGERIMENTO: Premendo 1,2,3... fino a 0 sulla tastiera, selezionerete un layer attivo da 1 a 10. Questo sarà nella fila superiore del pulsante Layer menzionato prima. Premendo Alt+1, Alt+2... fino ad Alt+0 selezionerete la riga dei layer che vanno dall'11 al 20.
  


  Con il Layer 11 attivo, aggiungete un nuovo cilindro (a questo punto dovreste già sapere come aggiungere una nuova Mesh).


  Premete il tasto TAB per passare alla modalità Edit. Premete il tasto Z per visualizzare il vostro cilindro come reticolato. Questa vista del vostro oggetto è molto utile e personalmente sono solito passare spesso dalla vista solida a quella di tipo reticolato. Premete A per selezionare tutti i vertici (se non sono già selezionati; quando si è in modalità Object, premendo A si selezionano tutti gli oggetti mentre in modalità Edit lo stesso tasto seleziona o deseleziona tutti i vertici).


  È giunto il momento di creare una pipa.


  Assumendo che vi troviate in una vista frontale ortogonale, il pulsante piccolo sulla destra del pulsante relativo alla modalità selezionata indica il simbolo della vista a reticolo...


  [image: ] Selezionate tutti i vertici.


  Scalate il vostro cilindro rimpicciolendolo dell'8%.


  Premete il tasto A per deselezionare tutti i vertici. Ora, selezionate tramite riquadro (usando il tasto B) solo i vertici superiori.
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  Scalate per ingrandire un pochino, premendo il tasto S e muovendo il mouse lontano dal centro della selezione. Premete A per deselezionare tutti i vertici e selezionate con lo strumento riquadro soltanto i vertici in basso.
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  Scalate premendo S e rimpicciolite un po' muovendo il vostro mouse verso il centro della selezione. Dopo ciò, aggiungete un nuovo cilindro, rimpicciolitelo, e create il resto della vostra pipa.
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  Scalate premendo S e rimpicciolite un po' muovendo il vostro mouse verso il centro della selezione. Dopo ciò, aggiungete un nuovo cilindro, rimpicciolitelo, e create il resto della vostra pipa.


  È il momento buono per sostituire il naso che abbiamo creato il mese scorso (usando un cono) con uno nuovo basato su un cilindro, dato che effettivamente non vogliamo dei contorni così affilati per il nostro naso-carota.


  Fate esattamente tutto ciò che abbiamo fatto con il cilindro poco fa per creare un altro braccio a rametto. Piazzatelo su un nuovo layer o nel layer dove già avete l'altro braccio. Potreste anche duplicare il braccio-rametto già creato selezionandolo e premendo Shift+D.



  Ora che avete tutti gli elementi nei vari layer, potete anche muovere tutti gli oggetti verso il layer di partenza (Layer 1), oppure premere Shift e il pulsante del relativo Layer che contiene degli oggetti per combinare la vista di tutti i layer che sono selezionati.


  
    SUGGERIMENTO: Per muovere un oggetto verso un altro layer, selezionate l'oggetto e premete il tasto M. Dalla finestra Move to Layer, selezionate dove volete spostare il vostro oggetto.
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  Il prossimo mese, aggiungeremo qualche colore alle nostre creazioni, introducendo le texture!


  Per questo mese, vi suggeriscohttp://www.blenderartists.org, un forum dove trovare le ultime notizie, annunci di lavoro, opere e tutto ciò che riguarda Blender.


  Inoltre, anche questo mese ho un video per voi. Andate su: http://www.youtube.com/watch?v=USyoT_Ha_bA, e guardate nel 1963 l'antenato di tutta la computer grafica, lo Sketchpad di Ivan Sutherland (la mia tavoletta grafica Wacom sta ancora piangendo).


  Blender - Parte 4


  Scritto da Nicholas Kopakakis


  Le texture e i materiali sono un punto cruciale. Senza di essi, ad esempio, ciò che abbiamo creato fin'ora è solo un pupazzo di neve grigio, con un naso grigio, mani grigie e un cappello, anch'esso grigio. Non è poi così realistico. Per cui, i materiali e le texture sono i modi usati per conferire realismo all'aspetto del nostro modello, attraverso immagini, semplici colori, ecc… .


  Dovete avere un materiale per potervi applicare sopra una texture (in automatico blender aggiunge un materiale agli oggetti per poterne visualizzare le superfici).


  Pertanto per questo mese introdurremo i materiali, tenendo da parte le texture per il mese prossimo, dato che è impossibile trattarli entrambi in un unico articolo.


  Ma, prima di tutto, aggiorniamo Blender. È disponibile un nuovo rilascio (2.66a) su http://www.blender.org/download/get-blender/ con tante novità e oltre 250 bug corretti.


  Carichiamo il file relativo al pupazzo di neve creato lo scorso mese. Dovrebbe assomigliare a questo in modalità oggetto:
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  Notate le piccole icone a destra della finestra Vista 3D. La quarta icona da destra (evidenziata) è relativa alla scheda Materiali.


  
    [image: ]

  


  Selezionate il cappello e premete il pulsante New:
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  Chiamate il nuovo materiale “Cappello”. La scheda materiali dovrebbe quindi assomigliare a questa:
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  Come potete vedere, ci sono tante cose che potremmo manipolare, ma qui introdurremo solo quelle basilari per ottenere un qualche tipo di ambiente realistico (possibilmente, nell'ultima parte di questa serie di articoli, potremo focalizzare l'attenzione su materiali e texture spiegandoli in dettaglio ma, per ora, sentitevi liberi di sperimentarli da soli).


  Blender fornisce una finestra d'anteprima, dove ispezionare il colore del nostro materiale. Inoltre, sulla destra, possiamo cambiare l'oggetto nell'anteprima (non va bene per tutti i nostri oggetti, ma aiuta a capire la resa del colore, ad esempio su sfere o scatole).


  Sotto Diffuse, vi è una riga bianca. Premete con il TSM (Tasto Sinistro del Mouse) su di essa per cambiarne il colore. Selezionate il colore che desiderate dalla ruota dei colori, o inserite manualmente i valori di Rosso, Verde e Blu sotto la ruota, o ancora usate il contagocce, strumento ben noto di tutte le applicazioni di grafica.


  Potete usare il pulsante HSV per selezionare il colore da Hue Saturation and Value, oppure potete usare i numeri esadecimali comunemente usati per specificare i colori delle pagine web. Io personalmente uso i colori RGB. I loro valori variano da 0 a 1 , indicando la percentuale di colore (0.2=20%, ad esempio).


  Sulla destra della ruota c'è un cursore che controlla l'intensità del colore. Se lo spingete tutto in basso, si otterrà il nero assoluto. Notate inoltre che così facendo i valori di Rosso, Verde e Blu passano a 0.


  Anche sotto Specular vi è una striscia bianca. Da questa possiamo scegliere il colore dei riflessi sugli oggetti riflettenti. Per esempio scegliete per Diffuse: colore Rosso=0.015, Verde=0, Blu=0.24, e per Specular: Rosso=0.915, Verde=1 , Blu=0. Inoltre nella finestra d'anteprima, scegliete come modello la scimmia.


  Assomiglia all'immagine sotto?
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    NOTA : La scimmia di Blender di fatto è uno scimpanzè, di nome Suzanne. Questo modello 3D, creato da Willem-Paul van Overbruggen, è stato introdotto alla comunità di blender come modello di prova per i materiali, le texture, le luci, ecc. I Suzanne Awards (simili agli Oscar awards) vengono conferiti annualmente agli artisti blender. http://en.wikipedia.org/wiki/Suzanne_Award
  


  Ora, torniamo al nostro pupazzo. Ricaricate il file pupazzodineve.blend, selezionate il piano che abbiamo usato come terreno e date TSM sulla scheda Material.
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  Premete New per creare un nuovo materiale e cambiatene il nome da “Material” a “Terreno”.


  Sotto Diffuse, fate clic col TSM New usato in precedenza per creare sulla striscia bianca e inserite i valori 0.5 per il Rosso e il Blu, 0.8 per il Verde. un nuovo materiale. Alla sua sinistra Sulla finestra Vista 3D, potete vedere c'è un'icona simile a quella dei che il colore del terreno passa ad una materiali di blender. superficie verde.


  Selezionate un bottone del pupazzo di neve e premete il pulsante New nella scheda dei materiali. Nominatelo “Bottone”, e, sotto Diffuse, coloratelo di rosso (ora dovreste sapere in che modo agire, ma, nel caso non fosse così, ponete R=1 , V e B=0):
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  Adesso, premendo il TDM, selezionate un altro bottone del pupazzo di neve. Sotto la scheda materiali, potete osservare il pulsante New usato in precedenza per creare un nuovo materiale. Alla sua sinistra c'è un'icona simile a quella dei materiali di blender.


  [image: ] Premetela e selezionate Bottone dalla lista:
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  I materiali che abbiamo creato sono registrati per usi successivi nel file blend e molti oggetti differenti possono condividere lo stesso materiale.


  Tenendo a mente tutto ciò, create i materiali per le mani, il cappello, il naso e la pipa. Poi assegnate il materiale “Bottone” agli altri bottoni o, se preferite, create un nuovo materiale per ogni bottone.
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  Per il cappello ho creato un materiale con comportamento Halo, in modo da creare un pupazzo di neve santo con due aureole!!! Davvero Santo!
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  Potete sperimentare anche gli altri due tipi di comportamenti dei materiali: Wire e Volume.


  Per questo mese, vi raccomando di scaricare e provare un gioco creato con blender con il suo motore di gioco proprietario: Yo frankie!

  http://www.yofrankie.org/


  Inoltre potete dare un'occhiata a blenderguru.com, un sito dedicato a blender, con tanti tutorial per principianti ed esperti, creato e mantenuto da Andrew Price, un artista blender davvero talentuoso. Divertitevi.

  http://www.blenderguru.com

  


  
    Nicholas vive e lavora in Grecia. Lavora per una casa di post- produzione (pubblicità-film) da diversi anni. Tre mesi fa è migrato su Ubuntu perché “renderizza più velocemente”. Blender ha trovato lui due anni fa.

    email: blender5d@gmail.com
  


  Blender - Parte 5


  di Nicholas Kopakakis


  Avere un modello disgustoso non è qualcosa cui aspirare per le proprie realizzazioni ovviamente, ma come mi disse un grande amico (nonché navigato artista 3D): “Si può salvare un pessimo modello con delle buone texture”.


  Questo mese proverò a spiegarvi le basi del texturing (la verità è che io conosco davvero solo le basi). Ci sono molti libri che descrivono le tecniche per applicare le texture, dato che esse sono una componente cruciale della modellazione 3D.


  Un Low poly in computer grafica è un reticolato solido caratterizzato da un esiguo numero di poligoni. Generalmente si usano i modelli low poly per motivi relativi alle performance in applicazioni in tempo reale come i giochi.


  I modelli High poly invece sono solitamente usati per film d'animazione o immagini in alta definizione, o in generale in condizioni in cui non abbiamo restrizioni legate alla resa in tempo reale

  (http://en.wikipedia.org/wiki/Low_poly)


  Vi faccio vedere un esempio in modo da farvi capire cosa sono le texture e di cosa sono capaci.


  Nell'immagine sotto abbiamo una sfera con un piano, illuminati da 3 luci.
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  Ora invece abbiamo lo stesso oggetto, ma questa volta con delle texture e delle mappature con le immagini per creare la superficie che ricopre la Terra.
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  E, ancora, abbiamo lo stesso oggetto con altre texture.
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  Infine, una palla di alluminio gettata come spazzatura su una spiaggia (cosa molto brutta).
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  Per l'ultimo modello ho usato un'immagine per la sabbia e per il foglio d'alluminio la texture Clouds con qualche scostamento dalla normale mappatura.


  Ma ora basta con gli esempi. Carichiamo in nostro file pupazzodineve.blend.


  Selezionate le tre sfere (il corpo) del nostro pupazzo di neve e premete Ctrl+J per unire i tre reticolati in un solo elemento. Rinominatelo “corpo” nella scheda Object.
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  Ora andate alla scheda Material e premete il pulsante New per creare un nuovo materiale per il corpo del nostro pupazzo.
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  Chiamate il materiale con un nome univoco, per esempio “corpo_Materiale”.


  Quindi premete la scheda Textures, vicino alla scheda Material.
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  Fate clic sul pulsante New per creare una nuova texture. Chiamatela “corpo_Texture” o come più vi piace.


  Trovate un'immagine della neve da usare come texture. C'è un gran bel sito che io uso molto allo scopo http://www.cgtextures.com. Potete registrarvi ed avere accesso a migliaia di immagini da usare come texture (con la registrazione gratuita potete scaricare 15MB di immagini al mese. Scaricate quelle a bassa risoluzione, andranno comunque bene). Per il nostro pupazzo di neve ho scaricato l'immagine Snow0041_5_S.jpg.


  Sotto il pulsante Type, selezionate Image or Movie.
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  Quindi premete Open sotto la selezione immagine e navigate fino al percorso che punta alla vostra immagine.
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  Sotto la sezione Mapping selezionate Sphere alla voce Projection e lasciate Coordinates così com'è (su Generated).
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  Sotto la sezione Influence, mettete una spunta su Emit e inserite il valore -0.800 per illuminare un po' l'immagine; sotto Geometry selezionate Normal e inserite come valore 4 per dare la sensazione di una superficie dura.
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  Lasciate il resto così com'è o sperimentate qualche voce per vedere cosa comporta (ricordate che sperimentare è una delle tre cose necessarie per padroneggiare Blender, le altre due sono “esercitati!”).


  Ora, per il terreno, ecco cosa ho fatto (ovviamente voi potrete usare un'immagine come alternativa). Ho creato una texture del tipo Clouds, aggiustandone alcune impostazioni.
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  utilizzando queste impostazioni:
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  Finite il pupazzo di neve creando e applicando delle texture al resto dei reticoli (mani, naso, bocca, ecc...).


  Sentitevi liberi di mandarmi le vostre creazioni del pupazzo di neve all'indirizzo blender5d@gmail.com, e mostrerò le migliori qui su Full Circle Magazine.


  Il prossimo mese, vi introdurrò all'uso del motore di rendering Cycles, un sistema di rendering veramente potente, presente in Blender a partire dalla versione 2.64. Inoltre, inizieremo un nuovo progetto. Inviatemi le vostre idee.


  Per questo mese, vi faccio vedere un gioco di nome Dead Cyborg creato da Endre Barath (http://www.deadcyborg.com). Un altro gioco creato con il motore di gioco di Blender. Divertitevi!


  
    Nicholas vive e lavora in Grecia. Lavora per una casa di post-produzione (pubblicità-film) da diversi anni ed è migrato a Ubuntu perché “renderizza più velocemente”. Potete scrivergli presso: blender5d@gmail.com
  


  Blender - Parte 6a


  Scritto Nicholas Kopakakis


  Come predefinito, Blender utilizza il suo motore di render proprietario chiamato Blender Render, ma personalmente preferisco “Cycles”. È incluso come un add-on dalla versione 2.64 (ora siamo alla 2.67) e io lo trovo fantastico perché, tra le altre cose, si possono apprezzare i risultati di rendering dei propri modelli in tempo reale!


  Ma andiamo per ordine. Trovate in alto nella finestra di Blender il pulsante a discesa che riporta la dicitura “Blender Render””.
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  Premetelo per aprire il menu e selezionate “Cycles Render”
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  Ora sistemiamo la nostra finestra per avvalerci del motore di rendering interattivo cycles.


  Nell'angolo in alto a destra della finestra della vista 3D (finestra principale), premete il TSM e trascinate il mouse per creare una nuova finestra 3D.
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  Quindi fate la stessa cosa con la finestra sinistra che avete ora, ma questa volta trascinate il mouse verso il basso per creare la terza finestra. Dovreste avere qualcosa simile all'immagine seguente.
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  Muovete il mouse sulla finestra in alto a sinistra, e premete lo 0 del tastierino numerico per impostare la visuale Camera.


  Nella finestra in basso a sinistra, invece, premete la piccola sfera bianca affianco al pulsante di modalità oggetto per visualizzare il menu Viewport Shadow.
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  Dal menu selezionate “Rendered”.


  Ora, ciò che sta succedendo in realtà è che, in questa finestra, il motore di render di Cycles crea “al volo” un'immagine fotorealistica del vostro modello. Potete navigare in questa finestra, potete ingrandire o rimpicciolire usando la rotella del mouse oppure + e – del tastierino numerico, potete traslare la vista tenendo premuto il stasto Shift e muovendo il mouse, ruotare la vista tenendo premuto il tasto centrale del mouse mentre lo si muove e, in generale, qualsiasi movimento della vista che abbiamo esaminato nella prima parte di questi articoli (FCM #68).


  È il momento buono per salvare la vostra configurazione di finestre. Sulla barra d'intestazione Info (quella che normalmente è in alto nella finestra), focalizzate l'attenzione sul pulsante della visuale che reca la scritta “Default” (chiamato così in maniera un po' stupida, dato che ci sono un bel po' di configurazioni chiamate Default in Blender).
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  Facendo clic sulla piccola icona sulla sinistra (il quadratino rosso), potete fare una selezione da una lista di configurazioni predefinite. Premete il pulsante + affianco a Default. Apparirà il valore “Default.001”. Rinominatelo con un nome che lo contraddistingua, tipo “Modello” per indicare che lo utilizzerete quando farete la modellazione d'oggetti. Quindi salvate il vostro file con un nome univoco; io ho chiamato il mio “Figure_base.blend”. La prossima volta che aprirete questo file, la configurazione “Modello” verrà aperta in automatico.


  
    SUGGERIMENTO: se fate partire un nuovo progetto, o ne caricate uno vecchio, la vostra configurazione personalizzata NON sarà presente. Ci sarà solo quella predefinita di Blender. Per avere la vostra configurazione personalizzata disponibile ogni qualvolta iniziate un nuovo progetto, dovete salvarla come file d'avvio premendo Ctrl-U. Notate che se sovrascrivete il file d'avvio premendo Ctrl-U, QUALSIASI cosa avete cambiato verrà salvata alla stessa stregua. Per esempio se eliminate il cubo e sovrascrivete il file d'avvio, la prossima volta il cubo non sarà là! Ovviamente potete sempre tornare alla configurazione d'avvio originale (File > Load Factory Settings).
  


  Muovete il vostro mouse sulla finestra Vista 3D, e premete sul tastierino numerico 5 e poi 1 per avere una vista ortogonale frontale. Trascinate la freccia blu del cubo giusto un pelino sopra il cursore, come illustrato.
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  Premete Shift-S e selezionate Cursor to Center se già non lo fosse, oppure Premete Ctrl-C. Ora aggiungete un piano e scalatelo di un fattore 10 (dovreste sapere come si fa). Create anche un Cono e una UV Sphere. Selezionate per ognuna lo smooth e muovetele in modo da avere una buona vista nella finestra 3D View in alto a sinistra (quella con la visuale Camera).


  Dovrebbe venir fuori qualcosa simile all'immagine sotto.
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  Selezionate il piano e premete la scheda Material sulla destra, sotto la finestra proprietà:


  [image: ]


  Un nuovo set di parametri da impostare a differenza del Blender Render! Premete il pulsante New (come fatto per il Blender Render) per aggiungere un nuovo materiale. Chiamatelo “Terreno”. Sotto Surface, vedrete il valore predefinito che è “Diffuse BSDF”. È come il Diffuse che abbiamo usato in FCM #72 per dipingere i nostri oggetti. Premetelo e dal menu selezionate “Glossy”.


  Quasi istantaneamente (dipende dalla potenza della propria CPU) potrete vedere nella finestra del Rendering 3D cosa avete realizzato. Impressionante, in così pochi clic! Ora, se vi piace, premete il pulsante colore e assegnate un colore per la vostra superficie lucida come uno specchio. Io ho scelto il viola (R:0.5, G:0.4, B:0.8). Appena cambiate il colore, Cycle comincia a renderizzare il risultato. Avrete un'anteprima in maniera molto rapida.


  Ora selezionate il cubo, aggiungete un nuovo materiale e impostate il tipo di superficie su Anisotropic BSDF per conferirgli un aspetto metallizzato. Probabilmente la tipologia di materiale che io preferisco.


  Qui sopra c'è tutto quello che abbiamo realizzato.
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  Più info su questo argomento il mese prossimo...


  
    Nicholas vive e lavora in Grecia. Lavora per una casa di post-produzione (pubblicità-film) da diversi anni; è migrato su Ubuntu perché “renderizza più velocemente”.

    Potete mandargli una mail all'indirizzo: blender5d@gmail.com
  


  Blender - Parte 6b


  di Nicholas Kopakakis


  Lo scorso mese abbiamo usato Cycles Render per creare l'immagine riportata in basso
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  Ora creiamo un'immagine simile con il motore di rendering di Blender.
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  La prima cosa che possiamo notare (almeno per me) sono le ombre. Le ombre che la nostra sorgente di luce Point proietta, con il motore di Blender, sono quasi nere. Questo fenomeno si verifica perché nel motore di rendering di Blender la luce viene emessa solo dalla lampada. Questo non è verosimile, dato che nel mondo reale tutti gli oggetti emettono o riflettono la luce.

  

  D'altro canto, il motore di rendering Cycles calcola la luce che ogni oggetto riceve da quelli che lo circondano. Potete osservare il cono e notare come l'ombra dal cubo si affievolisce con facilità (contrariamente a quella del cono ottenuta con Blender Renderer), e abbiamo una superficie d'appoggio riflettente e un cubo di metallo brillante nella nostra scena.

  

  Un altro aspetto assolutamente cruciale, nonché una delle differenze principali tra Blender e Cycles, è squisitamente tecnico.

  

  Andate su File > User Preference > System
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  Nell'angolo in basso a destra della scheda System potete indicare se il vostro computer supporta Nvidia CUDA alla voce Computer Device.
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  La mia GPU ha il supporto per CUDA, quindi posso abilitarlo. Potete verificarlo anche al link ufficiale di supporto di CUDA: https://developer.nvidia.com/cuda-gpus

  

  Se siete abbastanza fortunati da avere una scheda Nvidia CUDA, potete abilitarla alla voce Compute Device che ho menzionato in precedenza E nel pannello delle proprietà, alla scheda Render->Device->GPU Compute per avere tutta la potenza necessaria per i vostri rendering.


  [image: ]


  Cycles può usare i processori della GPU CUDA per renderizzare, il che è molto più veloce della CPU. Informazioni riguardo CUDA sono su wikipedia: http://en.wikipedia.org/wiki/CUDA

  

  Se non avete una GPU CUDA, potete usare il linguaggio Open Shading, ma è un tantino pieno di bug e non vi posso raccomandare questo metodo di renderizzazione, almeno per il momento. Nel prossimo futuro però ho la sensazione che sarà ancora più veloce della procedura di rendering di CUDA.
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  Ma ora è troppo con le informazioni tecniche.

  

  Guardiamo un'altra interessante funzionalità di Cycles. Aprite il file .blend che abbiamo cominciato lo scorso mese, o createne uno nuovo. Non dimenticate di selezionare in alto Cycles Render.
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  Inoltre selezionate nella finestra 3D view 'Rendered' per visualizzarne il risultato.
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  Selezionate la sfera, navigate nel Pannello Properties e cambiate l'ombreggiatore Surface dal consueto Diffuse BSDF in Emission.
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  Potete osservare nella finestra Preview il bell'effetto che abbiamo creato. Potete aggiustare i moduli Color e Strength per la luce che il nostro oggetto emette. Inoltre per tutti gli ombreggiatori potete aggiustare molti altri parametri (come la texture, ad esempio) premendo il piccolo punto alla destra dei valori di Color e Strength.
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  Selezionate il nostro cubo dall'aspetto metallico, premete il piccolo punto affianco a Color, e cambiatene la texture in Brick Texture. Osservate quindi il risultato nella vostra finestra 3D View e selezionate diverse texture finché non trovate qualcosa che vi aggradi.


  
    Suggerimento: I piccoli punti sono presenti in tutti gli ombreggiatori, non solo in Emission, e personalmente li trovo molto utili per creare velocemente cose interessanti.
  


  Un altro ombreggiatore notevole è Mix Shader. Come si può facilmente intuire dal suo nome, è un ombreggiatore che potete usare per mixare gli altri ombreggiatori. Due altri ombreggiatori, per essere precisi. Quindi, selezioniamo il nostro cono e cambiamone l'ombreggiatore da Diffuse BSDF in Mix Shader. Applichiamo quindi un Glass Shader e un Diffuse shader oppure un Glossy Shader e un Anisotropic Shader al cono. Cambiate il valore del parametro Fac per aggiustare la percentuale del secondo ombreggiatore (0.000 vuol dire 0% e 1.000 corrisponde al 100%).

  

  Guardate il risultato nella finestra Preview e aggiustate quindi le impostazioni come preferite.

  

  Un'altra cosa che vorrei menzionare in questa piccola deliziosa introduzione sul Cycles Renderer, è l'uso dei piani anziché delle luci.

  

  Molte persone che lavorano in Blender e Cycles, usano dei piani per illuminare le proprie scene. Sembra un'illuminazione “più realistica”, e io non ho alcuna ragione per contraddirli.

  

  Nell'immagine sotto potete vedere cosa ho realizzato io.
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  Per questo mese, seguite questo link http://vimeo.com/68010380 per godere di un bellissimo lavoro di tre persone e Blender (le congratulazioni vanno fatte a Javier Trapiella, Baol Bardot Bulsara e Robert Green).

  

  Inoltre, visitate www.blendernews.org per entrare e condividere esperienze con migliaia di artisti professionisti!

  

  http://blendernews.org/xe/?mid=Feature_Articles&document_srl=1274


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”. Potete mandargli una mail presso: blender5d@gmail.com
  


  Blender - Parte 7


  Scritto da Nicholas Kopakakis


  Dopo un mese di pausa, siamo di nuovo qui per esplorare i modificatori. Uno dei miei preferiti è Subdivision Surface!


  
    Suggerimento: I modificatori sono operazioni automatiche che lavorano sull'aspetto di un oggetto e sul suo rendering, ma non ne modificano l'effettiva geometria.
  


  Subdivision Surface (abbreviato in Subsurf) è un metodo per suddividere le facce di un reticolo in modo da conferirgli un aspetto più levigato, utilizzato per modellare superfici lisce complesse con dei reticoli semplici e con pochi vertici (sorgente: wiki.blender.org).


  Aprite un nuovo progetto in Blender e selezionate (se non è già fatto) il cubo.


  Ora, diamo un'occhiata alla scheda modificatori (illustrata in basso) nella finestra proprietà.
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  Focalizzate l'attenzione su una piccola chiave inglese. È questo il simbolo dei modificatori in Blender. Premete con il tasto sinistro del mouse l'icona della chiave e quindi il pulsante “Add modifier”.
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  Si aprirà una grande finestra con tutti i modificatori presenti in Blender. Per ora ci concentreremo su Subdivision Surface (Subsurf da ora in avanti). Trovate la voce (evidenziata nella figura qui sopra) e selezionatela per aggiungere tale modificatore al cubo.


  Il vostro cubo si trasformerà in un prisma a 24 facce! Ma se renderizzate l'immagine, potete vedere un oggetto a 96 facce... Strano! Vediamo perché avviene tutto questo.


  Quando aggiungete il modificatore Subsurf al vostro cubo, questi suddivide in maniera predefinita le facce del cubo (6) per 4, conferendogli un nuovo aspetto a 24 facce. Potete controllare quante volte suddividere le facce dei vostri oggetti nella sezione Subdivision come mostrato affianco. La scritta “View:1” indica che state suddividendo l'oggetto un'unica volta.


  Nella scheda Subdivision vi è un altro pulsante di controllo per modificare le suddivisioni in fase di rendering dell'immagine (Render:2). Ecco perché nella 3D view avete una figura a 24 facce (suddivisa un'unica volta), mentre, quando ne fate il rendering, avete una figura a 6x4x4=96 facce (suddivisa 2 volte). Premete la freccetta a destra per incrementare la View Subdivision in 2. Ora quello che vedete è quello di cui fate il rendering.
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  Ora aumentate le suddivisioni View e Render di uno. Per cui sotto Subdivisions dovreste avere 3 suddivisioni per la vista e per il render:
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  Sulla sinistra della finestra con la vista 3D, sotto Object Tools (premere T per mostrare/nascondere), premete smooth per lisciare l'aspetto del cubo.
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  Il vostro “cubo” dovrebbe assomigliare a qualcosa tipo questo:
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  Il segreto della potenza di Subsurf si rivela quando premete il tasto TAB per entrare in modalità modifica.
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  Potete vedere la sfera che abbiamo creato con Subsurf e la relativa figura di partenza, ossia il cubo. Non potete modificare la sfera (ricordate che il vostro effettivo oggetto è il cubo), ma potete modificare il cubo.


  Selezionate la faccia alta del cubo e premete il tasto E per estruderla, confermando tale estrusione con il tasto Invio. Scalatela del 50% premendo il tasto S e 0.5.


  Avete creato una tazza riccamente dettagliata!
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  Modificando il cubo, si modifica dinamicamente anche la sfera in maniera organica. Senza Subsurf servirebbero un sacco di tempo e di sforzi per creare questa tazza.


  Un altro strumento critico che si può usare con Subsurf è Loop Cut.


  
    Suggerimento: Loop Cut o Loop Subdivide (scorciatoia Ctrl-R) effettua un taglio delle facce inserendo un nuovo anello di spigoli che interseca il lato prescelto (fonte: wiki.blender.org)
  


  Deselezionate tutto premendo il tasto A e poi Ctrl-R. Passate il mouse sopra le facce del cubo e noterete una nuova poligonale viola “tagliare” i lati, come mostrato nella figura seguente:
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  Premete 2 o muovete la rotellina del mouse per aggiungere 2 tagli ad anello. Premete Invio per confermare.


  Fatto ciò, vi troverete 2 poligonali gialle selezionate che potrete traslare liberamente muovendo il mouse. Premete il tasto destro del mouse per piazzarle al centro del lato prescelto (in posizione predefinita)
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  Premete A per deselezionare tutto.


  Ora, per selezionare uno dei due lati tagliati, abbiamo bisogno di usare la combinazione Shift-Alt-tasto destro del mouse.


  
    Suggerimento: La vera combinazione per selezionare la poligonale di taglio è Alt-tasto destro del mouse, ma sotto Linux questa va in conflitto con le funzioni assegnate dal sistema al tasto Alt.
  


  Con l'anello di taglio più a sinistra selezionato, premete Ctrl-E per aprire il menu speciale per gli spigoli e selezionate Edge Slide come mostrato in figura nella prossima pagina.
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  Potete spostare l'anello muovendo il mouse o digitando direttamente il valore dello spostamento (a esempio -0.8). Deselezionate tutto premendo il tasto A e selezionate l'altro taglio. Muovetelo di 0.8 unità.


  Create un altro duplice taglio sull'altro lato del cubo
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  Selezionate e deselezionate qualsiasi cosa desiderate. Muovete un singolo vertice e muovetelo un po' per vedere cosa succede al vostro oggetto. Selezionate due vertici e scalateli riducendone o aumentandone la distanza. Mentre siete in Edit Mode, aggiungete una nuova figura, a esempio un piano, e notate cosa vien fuori.


  Il prossimo mese continueremo il nostro viaggio con Subsurf, provando a creare qualcosa. Per favore mandatemi suggerimenti o domande all'indirizzo: blender5d@gmail.com


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”.

    Potete mandargli una mail blender5d@gmail.com
  


  Blender - Parte 8


  di Nicholas Kopakakis


  Lo scorso mese abbiamo introdotto il modificatore SubSurf (Subdivision Surface), uno strumento molto utile per creare modelli levigati e di alta qualità. Bisogna fare molta pratica per familiarizzare con questo strumento e rivelarne le potenzialità. Vediamo qualche esempio.


  Creare un uovo


  Aprite un nuovo progetto in Blender e aggiungetevi un cubo (se non dovesse già esserci). Con il mouse nella finestra Vista 3D, premete il tasto TAB per passare alla modalità Edit. Premete A per deselezionare tutti i vertici ed evidenziate solo i quattro vertici superiori.


  [image: ]


  Premete il tasto S e digitate 0.5 per scalare la faccia selezionata del 50%. Quindi tocca al tasto G (G di Grab) e al valore 0.1 per muovere la faccia selezionata verso l'alto. Abbiamo qualcosa di simile ad una piramide Maya. Premete il tasto TAB per uscire dalla modalità Edit e ritornare alla modalità oggetto.
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  È questo il potere di Subsurf: da una piramide possiamo ricavare un uovo! Andate ora nel pannello delle proprietà sulla destra e selezionate la scheda modificatori che ha per icona una chiave inglese per accedere al modificatore SubSurf. Aggiungete il modificatore, e incrementate i valori di View e Render a 3. Sulla sinistra, sotto la scheda Object Tools, applicate l'ombreggiatore Smooth. Ecco l'uovo.
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    Suggerimenti: il “metodo non distruttivo” è qualcosa che potete cogliere utilizzando i modificatori. Potete creare un oggetto usando un modificatore, ma qualora decideste di non usare più tale modificatore, è molto semplice eliminarlo o modificarlo. In effetti il modello di partenza giace lì, “sotto” le vostre modifiche. Quando però premete il tasto Apply nella scheda modificatore, “distruggete” questa funzionalità.
  


  OK. Abbiamo conosciuto SubSurf in modalità non distruttiva. Ora possiamo vedere che tipo di reticolo possiamo creare effettivamente applicando il nostro modificatore ai modelli.


  Creare un proiettile


  A dire il vero, non sono un grande fan di armi e proiettili. Ma, nel momento in cui modellate un oggetto, avete bisogno di sapere a cosa assomiglia. Grazie a Dio esistono Google e un sacco di banche di immagini per questo scopo. Per cui, dopo pochi clic, ho trovato un immagine di proiettile su cui lavorare (nel prossimo articolo vi mostrerò come usare le immagini come cianografia per modellare gli oggetti).

  

  Cominciamo un nuovo progetto con un cubo all'interno. Sul cubo, aggiungete il modificatore SubSurf e portate a 3 sia View che Render. Premete S per scalare il cubo, Z per riferire la procedura all'asse Z e 1.5 per scalare. Premere poi il tasto TAB per entrare in modalità Edit. Selezionate i quattro vertici superiori e premete il tasto E per estrudere. La dimensione 1 dovrebbe andar bene. Dovreste avere qualcosa di simile all'immagine sotto.
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  Premete Ctrl + R. Dopo aver premuto il TSM per accettare il taglio ad anello, muovetelo verso il basso, verso la base del vostro modello. Notate che l'oggetto modificato cambia la propria forma. Adesso possiamo accettare la modifica premendo Apply nella scheda dei modificatori.
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  Tornate nella modalità Edit per vedere cos'è successo. Abbiamo un reticolo creato dal modificatore SubSurf!

  

  Premete Alt-Ctrl-R per selezionare una serie di superfici disposte ad anello.


  [image: ]


  Premete E e poi Invio per confermare l'estrusione. Digitate S per scalare la vostra selezione davvero di pochissimo. Pigiate G per muovere la selezione in basso, verso il centro del proiettile. Scalatela un po' per creare qualcosa di simile all'immagine sotto.
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  OK. Abbiamo una forma di proiettile elementare. Aggiustate qualsiasi cosa desiderate, iniziate un nuovo progetto e create un razzo o qualcos'altro usando il modificatore SubSurf. Quando sarete felici delle vostre figure modificate, applicate il modificatore e ultimate il vostro progetto. Ricordate che quando applicate un modificatore avete un nuovo reticolo, per cui potrete ri-applicare nuovamente il modificatore che vi pare. Più avanti parleremo del blocco dei modificatori e di come funziona.

  

  Il mese prossimo, introdurremo le curve di Bezier e modellerò il logo della mia squadra preferita.

  

  Per questo mese, posso suggerire la comunità blendswap.com. Artisti 3D da qualsiasi parte del mondo possono postare i loro lavori con blender e avere opportunità di lavoro concrete!


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”. Potete mandargli una mail all'indirizzo blender5d@gmail.com
  


  Blender - Parte 9a


  Scritto da Nicholas Kopakakis


  Come vi avevo promesso, questo mese introdurremo le Curve di Bezier.


  Le Curve di Bezier (chiamate così in onore dell'ingegnere francese Pierre Bezier) sono usate nella computer grafica per impostare le coordinate di una curva uniforme in maniera molto semplice.


  Vediamo di cosa stiamo parlando. Iniziamo un nuovo progetto in Blender e sbarazziamoci del cubo (selezionare il cubo, premere X per eliminare e confermare).


  Adesso premiamo Ctrl-A per avere il menù Add --> Curve --> Bezier.


  [image: ]


  Premere R per ruotare, X per selezionare l'asse X e 90 per l'angolo di rotazione. Quindi premiamo sul Tastierino Numerico 1 per la vista frontale e 5 per la vista ortogonale.


  Dovremmo ottenere qualcosa di simile all'immagine sotto:
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  Premiamo il tasto TAB per entrare in modalità Edit. Potete osservare una figura piuttosto strana, che somiglia a una spina di pesce o a una serie di frecce direzionali, comunque vogliate chiamarla...
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  Le cose interessanti sono le due linee rosa che rappresentano gli spigoli della figura (tale “figura” è il vero e proprio segmento della curva). Concentriamoci sulla linea rosa a destra. Premiamo il tasto A per deselezionare tutto. Selezioniamo il vertice al centro (chiamato punto di controllo) come mostrato sotto::/p>
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  Notate che gli altri due vertici (detti maniglie) vengono selezionati automaticamente. Premere il tasto G per muovere il punto di controllo. Il lato destro della curva si muoverà. Premere il TDM (tasto destro del mouse) per cancellare o il TSM (tasto sinistro del mouse) per confermare il movimento. Ora, selezioniamo il vertice più a destra (che per il momento coincide con la maniglia). Muoviamolo come fatto in precedenza col punto di controllo.


  Il punto di controllo rimarrà in posizione, mentre le maniglie si sposteranno. Inoltre, la curvatura della curva si modifica! Anche muovendo le altre maniglie la curva cambia. Muovendo le maniglie verso il punto di controllo cambia la concavità delle rispettive curve.


  Con il punto di controllo destro selezionato, premiamo CTRL+TSM. Stiamo creando un altro punto di controllo e modificando a tutti gli effetti la curva. Il punto di controllo appena creato è ora l'ultimo e l'ultimo rappresenta il punto in cui la curva finisce. Se vogliamo estendere la curva dal lato di partenza, selezioniamo il lato iniziale e premiamo CTRL+TSM per aggiungere un nuovo punto di controllo come spigolo di partenza. Se vogliamo chiudere la curva, selezioniamo i due spigoli e premiamo F per aggiungervi un segmento che li chiuda.


  Questo è tutto quello di cui abbiamo bisogno per creare il nostro Logo con le curve di Bezier.


  Per maggiori dettagli sulle curve di Bezier andate su http://wiki.blender.org/index.php/Doc:2.6/Manual/Modeling/Curves


  Il nostro obiettivo è creare un logo tridimensionale partendo da un'immagine bidimensionale; cominceremo da qualcosa di semplice. La mia squadra del cuore in Grecia è il Panathinaikos, quindi cerchiamo su Google il logo del club.


  Ho trovato un logo che fa assolutamente al caso nostro.
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  Non mi interessa particolarmente la scritta, per cui volendo si potrebbe rimuovere con Gimp. Ma va bene per le mie intenzioni, quindi la lascerò così com'è. La cosa buona è che dobbiamo modellare solo un trifoglio. Compito semplice per una curva di Bezier.


  Quindi, cominciamo un nuovo progetto, rimuoviamo il cubo e posizioniamoci in una vista Ortogonale frontale nella finestra 3D View.


  Uno strumento potente che ci conferisce Blender è la possibilità di usare un'immagine come piantina sullo sfondo per semplificare la modellazione.


  Premiamo il tasto N per visualizzare/nascondere il pannello sulla destra della finestra 3D View (pannello Properties). Rendiamolo visibile, scorriamo verso il basso e spuntiamo l'opzione Background Images.
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  Premiamo il tasto Open e navighiamo verso la cartella in cui abbiamo scaricato l'immagine. Selezioniamola e apriamola.


  L'immagine apparirà sullo sfondo. Dal pannello che appare proprio sotto al pulsante Open usato prima, possiamo alterare alcune sue proprietà (la trasparenza o la posizione, ad esempio).
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    Suggerimento: Le immagini sullo sfondo sono visibili solo con la vista Ortogonale e con precise angolazioni (frontale, da sinistra, da destra, dall'alto, ecc.). In seguito, vi mostrerò le tecniche per manipolare le immagini come oggetti 3D visibili da ogni angolo e ogni direzione.
  


  Ora aggiungiamo una Curva --> Bezier. Premiamo il tasto TAB per andare in modalità Edit e usiamo CTRL+TSM per aggiungere i punti di controllo necessari. Creiamo una linea che copra il perimetro del trifoglio come illustrato in basso. Usiamo i manipolatori per creare le curve di cui abbiamo bisogno:
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  Fatto ciò, non avremo più bisogno dell'immagine sullo sfondo. Deselezioniamo l'opzione corrispondente sul pannello proprietà o premiamo la X subito sotto a destra del pulsante Add.


  A questo punto, abbiamo una figura bidimensionale e avremo un po' di lavoro da fare per renderla tridimensionale.
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  Continua...

  


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”. Potete mandargli una mail all'indirizzo: blender5d@gmail.com
  


  Blender - Parte 9b


  di Nicholas Kopakakis


  Lo scorso mese abbiamo creato un trifoglio usando le curve di Bezier, oltre a usare un'immagine di sfondo per modellarlo. Adesso è tempo di aggiungere la terza dimensione al nostro modello.

  

  Sulla destra, sotto la finestra Properties, selezionate la scheda Curve:
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  Scorrete in basso e troverete il pannello Geometry. Inserite il valore 0.2 in Extrude, come mostrato nell'immagine qui sotto:
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  Potete controllare nella finestra 3D View che la vostra immagine comincia ad avere una profondità.
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  Ora, una cosa molto interessante si trova nel pannello Shape della finestra Properties:
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  Potete vedere che il pulsante 3D è selezionato. Premete 2D. Alla voce Fill, selezionate Back. Il vostro modello sarà 'riempito' nella parte posteriore. Adesso selezionate Front. Come ci si poteva aspettare, il modello viene 'riempito' nella parte frontale. E come potete immaginare, se doveste selezionare None, nulla verrà 'riempito'. Selezioniamo Both.

  

  Avete quindi ora un modello solido in 3D, come si evince dalla finestra 3D View.
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  Modifichiamo qualcosa. Nel pannello Geometry, menzionato in precedenza, c'è il parametro Bevel. In Depth, inserite il valore 0.03, e in Resolution il valore 2. Potete alterare il valore di Depth se desiderate smussare più o meno gli spigoli del vostro modello. Per me 0.03 va bene.

  

  Adesso è il momento di aggiungere i materiali al nostro modello. Date un'occhiata alle precedenti uscite di Full Circle Magazine se non ricordate come farlo. Il mio materiale preferito è il vetro, per cui ho creato un vetro verde per il mio trifoglio. Inoltre, aggiungete un piano bianco come sfondo per avere una migliore resa visiva.
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  Il mese prossimo introdurremo il Testo. Aggiungeremo del testo alla nostra immagine creata in questa edizione, ma esamineremo anche una tecnica per realizzare cose interessanti con i nostri modelli utilizzando un modificatore davvero eccezionale. Rimanete sintonizzati!

  

  Il 3 novembre, www.blender.org ha cambiato il proprio look. Per cui, non ho da suggerire nessun altro sito. Esplorate il nuovo e divertitevi!


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”. Potete mandargli una mail all'indirizzo: blender5d@gmail.com
  


  Blender - Parte 10a


  di Nicholas Kopakakis


  Buon anno a tutti!

  

  Questo mese ci divertiremo un po' con i testi in Blender. Per cui, avviate Blender ed eliminate il cubo predefinito (selezionate il cubo, premete X e confermate l'eliminazione). Adesso, premete il tasto A per aggiungere un nuovo oggetto nella vostra scena. Aggiungete il testo.
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  La prima cosa che noterete è che, per qualche motivo, blender aggiunge gli oggetti di testo dinanzi alla vista dall'alto. Io preferisco porlo davanti alla vista frontale, per cui ruotiamo il nostro testo di 90 gradi sull'asse X (Premete il tasto R, poi il tasto X e digitate 90).

  

  Ora, usando il tastierino numerico premete 1 per la vista frontale e 5 per la vista ortogonale. Dovreste avere qualcosa come l'immagine in basso.
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  Ora che abbiamo un aspetto migliore per il nostro testo, cambiamolo. Premete il tasto TAB per entrare in modalità modifica. Cambiate il predefinito “Text” in “Full Circle Magazine”. Uscite dalla modalità modifica premendo nuovamente il tasto TAB. Grande!

  

  Tutto sommato, però, abbiamo un testo veramente noioso (sebbene dica “Full Circle Magazine”). Con l'oggetto di testo selezionato, esaminiamo la finestra Properties. Selezionate la scheda che ha per icona una F per rivelare alcuni dettagli interessanti sul nostro oggetto.
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  Prima di tutto, cambiate il nome del nostro oggetto dal solito “Text” in “FCM”. Quindi cambiate il valore extrude, alla voce Geometry, in 0.2. Non vedrete alcuna differenza con il vostro testo. Ma, se ruotate la vista (tenendo premuto il pulsante centrale del mouse e muovendo quest'ultimo, oppure premendo il tasti 2,4,6 e 8 sul tastierino numerico) potete vedere che abbiamo estruso il nostro testo. Fantastico!

  

  Possiamo anche aggiustare l'ammontare del fattore bevel.
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  Cambiate il valore di Depth in 0.05 e Resolution in 10.
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  Ok. Adesso cambiamo il valore di Font.
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  Premete l'icona file (ossia quella tra la F e la X) e navigate nella vostra cartella Font. Selezionate il Font dei vostri desideri. Io ho scelto Isabella (cercate nei repositories il pacchetto ubuntustudio-font-meta). I valori inseriti precedentemente in Geometry non vanno bene con questo font. Imposto quindi Extrude=0.05 e Bevel=0.02.

  

  Ok, adesso aggiungete una scatola e ruotatela, scalatela, muovetela. Usate anche le textures! Sarà facile creare un'immagine come quella qui sotto.
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  Continua...


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”. Potete mandargli una mail all'indirizzo: blender5d@gmail.com
  


  Blender - Parte 10b


  di Nicholas Kopakakis


  Lo scorso mese abbiamo creato un oggetto Testo e lo abbiamo manipolato (rotazione, scala, ecc...). Ora vediamo qualche altra miglioria che Blender ci permette di applicare.

  

  Sulla destra, sotto la scheda F, abbiamo tutti gli ottimi strumenti per modificare il font del nostro oggetto, che come ricorderete abbiamo visto lo scorso mese. Rimarremo su quelli basilari per ora, sebbene Blender fornisca molte personalizzazioni. Quindi, alla voce Font, troviamo Size e Shear. Potrete rendere il testo più grande o più piccolo modificando il valore di Size, così come potrete inclinare il testo verso sinistra o destra dando a Shear rispettivamente un valore negativo o positivo.
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  Inoltre, alla voce Shape, potrete modificare la risoluzione dell'oggetto Testo o il suo riempimento (Fill). Fate dei test con questi valori e capirete meglio di quanto io non possa spiegarvi.
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  Ora, diamo il via ad un nuovo progetto per esaminare qualcos'altro (vi spiegherò dopo il perché abbiamo la necessità di iniziare un nuovo progetto per questo esempio). Non eliminate il cubo, spostatelo giusto un pochino e aggiungete un nuovo oggetto Testo premendo Shift + A! Text o dal menu che si apre facendo clic su Add (questo lo sapete da ora!). Ruotate l'oggetto Testo per porlo davanti al cubo nella vista frontale, ed aumentate il valore di estrusione nella scheda F a 0,5. Muovete i vostri oggetti (testo e cubo) finché non avrete qualcosa simile all'immagine in basso:
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  Per il nostro esempio è fondamentale che i due oggetti si intersechino.

  

  È tempo di vedere qualcosa di interessante. Con l'oggetto selezionato, premete Alt-C. Dal menu che si apre, selezionate Mesh from Curve/Meta/Surf/Text.
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  Si è verificata una cosa molto interessante. Blender ha creato un oggetto reticolato che può essere manipolato come qualsiasi altro oggetto. Premete il tasto TAB per entrare in modalità Edit, e scoprite da soli di cosa sto parlando.
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  Il motivo per il quale ho voluto convertire il testo in un oggetto reticolato è presto detto: usare i modificatori che mi piacciono tanto e che invito a sperimentare, come il modificatore Boolean. Quindi selezionate il cubo e aprite la scheda dei modificatori.
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  Aggiungete un nuovo modificatore chiamato Boolean.
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  Sotto la scheda Operation selezionate Difference e in Object selezionate l'oggetto creato a partire dal testo (non lo abbiamo rinominato, per cui si chiamerà “Text”). Quindi premete Apply.
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  Dopo qualche tempo, dipende dalla potenza e dalla memoria del vostro computer, verrà completata l'operazione Boolean. Per cui, se muovete il testo o il cubo potrete vedere cosa avete combinato.

  

  Blender ha calcolato la differenza tra i due oggetti e l'ha ritagliata dall'oggetto al quale abbiamo applicato il modificatore.

  

  Se avessimo provato con oggetti più complessi, come il testo “Full Circle Magazine” (con un font elegante e tutte le curve che avevamo applicato), Blender sarebbe andato in crash. Ecco perché abbiamo usato un oggetto di testo semplice. Anche il comando Convert-to-mesh sarebbe stato più esoso in termini di richieste per poter essere gestito da Blender.

  

  Il modificatore Boolean è comunque molto utile e leggero qualora si abbiano oggetti semplici come cubi o piramidi, giusto per fare un esempio.
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  Per questo mese, vi suggerisco il sito http://gooseberry.blender.org/. È un nuovo progetto, appena avviato dall'Istituto Blender.

  

  Il prossimo mese, continueremo con il testo introducendo un po' più di movimento, o meglio un'animazione. Proveremo con qualcosa di simile all'introduzione di Star Wars: “Molto tempo fa, in una galassia molto, molto lontana...”

  

  Divertitevi!


  
    Nicholas vive e lavora in Grecia. Ha lavorato per una casa di post-produzione per diversi anni ed è migrato su Ubuntu perché “renderizza più velocemente”. Potete mandargli una mail all'indirizzo email: blender5d@gmail.com
  


  Il gruppo FMC Italia


  ENTRA ANCHE TU NEL GRUPPO FCM
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  La rivista Full Circle nasce da una idea della Comunità degli utenti di Ubuntu e vive del lavoro di coloro che hanno scelto di dedicare parte del loro tempo libero alla riuscita di questo progetto. È un progetto veramente aperto : tutti possono collaborare, in un modo o nell’altro. C’è chi scrive gli articoli, chi li corregge, chi li traduce, chi li impagina e così via.


  Anche tu puoi collaborare attivamente alla continua crescita di questa rivista, il cui unico scopo è la diffusione della cultura del Software Libero.


  Se conosci l'inglese e il Software Libero è la tua passione, puoi collaborare:


  
    	Scrivendo articoli in inglese;


    	Traducendo in italiano i testi;


    	Revisionando i testi;


    	Impaginandoli con Scribus;



    	Impaginandoli con Sigil.

  


  Se vuoi saperne di più, visita la pagina Partecipare del nostro wiki.

  

  Oggi partecipare è ancora più facile!


  Coordinatori del gruppo: Fabrizio Nicastro - Mattia Rizzolo


  I collegamenti per scaricare tutti i numeri di Full Circle Magazine in italiano li trovi nel nostro Archivio.


  Cerchi un articolo pubblicato su FCM?


  Nel wiki trovi anche l'Indice generale di tutti i numeri pubblicati, comprensivo di titolo, autore e pagina dell'articolo. Fai clic qui per consultarlo!

  


  Questa rivista è stata tradotta dal Gruppo FCM della comunità Ubuntu-it.


  Per ogni altra informazione visitate il nostro sito web: http://wiki.ubuntu-it.org/Fcm.
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